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How Do I Share Files? 
Any user from anywhere in the world who has a computer with Internet browser or FTP client can access EFT and 
share files—provided the computer on which the user is attempting to connect to EFT is allowed access, and the 
user has an account defined on EFT. The user account itself or the group to which it belongs must have the 
appropriate permissions (upload, download, create folders, and so on) assigned on the VFS tab of the 
administration interface. When users log in to EFT, they connect only to their home folders and cannot browse 
above their home folders. 

EFT allows the following methods through which you can share files using EFT: 

• Workspaces - Users (with a Workspaces license) can share files and folders with other EFT users through 
the Web Transfer Client. Additionally, if the EFT administrator allows it, you can share files with external 
users and share your Workspaces folders. 

• EFT Outlook Add-In - With the EFT Outlook Add-In, users can send files via email and the recipient can pick 
them up in their web browser through Workspaces. 

• Web Transfer Client (WTC) - The WTC is a browser-based file transfer client that allows users to transfer 
files over HTTP or HTTPS. The WTC can resume transfers and can send multiple files concurrently. It also 
has drag-and-drop support, integrity validation, a transfer queue, and no file-size limit. 

• If the user is trying to connect to the WTC with an older, unsupported browser, a "plain text" 
client (shown below) appears instead of the WTC. 

• If the administrator has not enabled the WTC for a Settings Template or user account, a "plain 
text" client appears instead of the WTC. 

 

• Mobile Transfer Client (MTC) -  The MTC is a mobile app that provides a way for iOS and Android phone 
and tablet users to securely connect to EFT and upload and download files while providing a number of 
centrally managed security controls for safeguarding your corporate data. Refer to Mobile Transfer Client 
(MTC) for details. 

• Globalscape's CuteFTP® or a similar "FTP client" - Any FTP client can be used to connect to EFT and 
transfer files. For more information about CuteFTP, refer to https://www.globalscape.com/cuteftp or 
online help. 

https://www.globalscape.com/cuteftp
http://help.globalscape.com/help/cuteftp9/
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• Windows Explorer - When logged in to the EFT computer, administrators can manage files on EFT using 
Windows Explorer. By default, user files are stored in the C:\Inetpub\EFTRoot\ folder in the Usr folder 
under the Site on which their account is defined. In the illustration below, user imauser, defined on 
GSSite, stores files in the imauser folder. Anyone with the proper permissions on the EFT computer can 
drag and drop, copy and paste, and create and delete files and folders, just like in Windows Explorer. For 
example, suppose user imauser has gone over her quota and can no longer upload any files. Instead of 
increasing the quota for the folder, you can delete files from the imauser folder that imauser no longer 
wants, or move them to some other accessible storage. 

 

• Command Prompt - At a command prompt, you can enable an FTP session and transfer files, if you are 
familiar with basic DOS commands. Refer to the KB article "Can I use a Windows Command Prompt to 
send FTP commands to a server?" for list of common commands. To allow an FTP session via a command 
line to accept double slashes // when navigating paths, in EFT v7.2 and later, you must enable the 
following registry setting on the EFT server: 

HKEY_LOCAL_MACHINE\SOFTWARE\GlobalSCAPE Inc.\EFT Server 
7.2\FixDoubleSlashInPathsForFTP 
0 = disabled; 1 = enabled 

• Sending Files with the Outlook Add-In 

• Emailing Files from within the WTC 

http://kb.globalscape.com/KnowledgebaseArticle10407.aspx
http://kb.globalscape.com/KnowledgebaseArticle10407.aspx
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WTC Administration 
The topics in this section describe administration of the Web Transfer Client (WTC). For instructions for using the 
Web Transfer Client, refer to the Web Transfer Client User Guide. 

 SAML (Web SSO) Authentication 

 WTC Error Messages in EFT 

Enabling User Access to the Web Transfer Client 
Before users can log in to EFT using the Web Transfer Client (WTC), EFT administrator must configure EFT to allow 
connections from the WTC. Active Directory domain users must have logon permission on EFT computer in order 
to log on to EFT through the WTC. This is accomplished by adding AD domain users to the "Allow log on locally" list 
on EFT computer. If an AD domain user is not in this list, logging on to EFT through the WTC will fail and an error 
message appears informing the user that Local login access is required to log on to EFT. 

 

Stopping and restarting the Site disconnects everybody who is connected; users must log back in. 

To configure EFT to allow Web Transfer Client Connections 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Settings Template or user account. 

3. In the right pane, click the Connections tab. 
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4. In the Protocols area, select the Allow Web Transfer Client over HTTP/S check box. If this check box is not 

available, you have not activated the Web Transfer Client licenses or the trial has expired. 

 

HTTPS must also be enabled. 

5. Click Apply. 

Localization (Language) Settings 
The EFT administrator can specify which language is the default by editing the WTC configuration file. However, 
the end-user's browser settings take precedence over the default language setting. English is used if the browser 
and the default languages are not available. 

For example, if the browser is set to German, it will automatically use German, no matter what is in the 
configuration file. You can also add other languages by translating the language file and adding it to the 
configuration file. 

The language files, e.g., main_en.json, are saved in C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise\web\public\EFTClient\jument\i18n. Be sure to not edit any of the code, just edit the display text. That 
is, in the example below, you would only change the highlighted text between the quotation marks. 

 



Workspaces v1.3 User Guide 

11 

Be sure to make a copy of the file and then edit the copy, so you can revert, if necessary. The language file must be 
named main_<country code>.json. A list of ISO 2-letter codes can be found online, such as 
http://www.nationsonline.org/oneworld/country_code_list.htm. 

For example, a French language file would be named main_fr.json, and the code in the configuration file 
would be: 

{ 
  code: 'fr', 
  name: 'Française', 
  region: 'France' 
}, 

To specify the default language setting 

1. In C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\scripts, find 
the  adminConfig.js file. (There is a number in front of the name.) 

2. Open the configuration file in a text editor, such as Notepad++. 
3. Look for the "Defines the languages available" section and the following text: 

gsb.config.languages = [ 
    { 
        code: 'en', 
        name: 'English', 
        region: 'United States' 
    }, 
    { 
        code: 'nl', 
        name: 'Nederland', 
        region: 'Nederland' 
    }, 
    { 
        code: 'de', 
        name: 'Deutsche', 
        region: 'Deutschland' 
    } 
]; 

4. The default language appears first. For example, if you want German (Deutsche) to be the default language, move it 
to the top. 

5. If you create your own language file, add it to the language section in the configuration file. 

WTC Error Messages in EFT 
WTC error messages and prompts appear for a variety of scenarios. In EFT version 7.3.2, the WTC licensing model 
changed from concurrent licenses to client-access licenses (CAL). In addition to the error banner that appears 
when licenses have been exceeded, error messages also appear in the Windows Event Log and in the EFT log. 

In the EFT log: 

• When WTC license count is reaching the maximum, the message is: "ERROR COMMON <> - WTC license 
count nearing capacity: 10 assigned out of 10 available." 

• When the WTC license maximum is exceeded, the message is: "ERROR COMMON <> - WTC license count 
exceeded: 11 assigned out of 10 available." 

http://www.nationsonline.org/oneworld/country_code_list.htm
https://notepad-plus-plus.org/download/v6.8.3.html


WTC Administration 

12 

 
In the Windows Event Log, the following messages appear: 

When EFT is approaching the maximum allowed seats: 

 
When EFT has exceeded the maximum allowed seats: 
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Disable CRC 
The Web Transfer Client (WTC) can validate the integrity of files transferred to and from EFT. Cyclical Redundancy 
Check (CRC32) is enabled on the WTC by default. The EFT administrator must have enabled CRC in its FTP 
configuration to take advantage of this feature. 

With CRC enabled, when the WTC transfers a file to or from EFT, it automatically queries EFT for the CRC value of 
the file, then compares it to the CRC value for the local file. If they match, the transfer is reported as successful. If 
they do not match, the system reports a "CRC Failure." The user can then retry the transfer, if necessary. The client 
does not automatically retry the transfer if they do not match. 

If upload verifications are not required, you can disable CRC in the WTC configuration file. 

 

The HTML5 version of the Web Transfer Client does not support a CRC-check for downloaded files because of the limited 
access of html/js to the client file system. The process of initiating a download is human driven and can NOT be 
intercepted by a JavaScript API; it is wholly managed by the browser itself, for security reasons. Further, the browser 
cannot arbitrarily read files on the local file system (for obvious security reasons), so EFT cannot read contents of 
downloaded files to do CRC32, and thus cannot issue a follow-up HEAD request to verify the integrity of the download. 

To disable CRC 

1. In C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\scripts, find 
the adminConfig.js file. (There is a number in front of the name.) 

2. Open the configuration file in a text editor, such as Notepad++. (It may be necessary to change the 
extension from JS to TXT to view it properly.) 

3. At the very bottom of the file, find the following text: 

gsb.config.crcVerifications = true; 

4. Change true to false, then save the file. 

5. If you changed the name of the file to edit it, be sure to change it back. 

6. Now transfers will be processed without CRC. 

  

Disabling "Update Your Browser" Prompts 
If end users do not have the necessary permissions to install an updated browser that supports certain features 
(such as folder uploads in Internet Explorer), administrators can enable a prompt that tells the user to update the 
browser, similar to the following prompt: 

 
To disable prompts 

1. In the /scripts/ folder, open adminConfig.js (in the format of HHHHHHHH.adminConfig.js, 
where H is a hex value) in a text editor. The file contains JavaScript similar to the following text: 

'use strict'; 
/* global gsb */ 
gsb.config.disableSiteInitPopups = false; 

https://notepad-plus-plus.org/download/v6.8.3.html
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2. Edit the last line to change it from false to true: 

gsb.config.disableSiteInitPopups = false; 

3. Save changes to the file. 

Terms and Conditions 
Web Transfer Client (HTML5 version) users can be asked to accept or decline a Terms and Conditions page before 
continuing to the WTC. It is not available by default. 

To enable the Terms and Conditions page 

1. Copy the \EFTClient\ folder from \web\public\ to \web\custom\. (Refer to Customizing the WTC for 
information about customizations.) 

2. Create a file names terms.html. 

3. Save the file in \web\custom\EFTClient\jument. 

To view an example Terms and Conditions file, right-click terms.txt, and then click Save As. You may use this 
example for your Terms and Conditions page, making sure to review and revise for your company. Be sure to save 
the file as terms.html in the appropriate folder as explained above. 

When creating your terms.html file, you do not need the <html> and <body> tags, because the file will be inserted 
into a frame in the WTC. You do, however, need to use HTML tags for formatting things like headings, paragraphs, 
and quotation marks, as shown below: 

<h3>Web Transfer Client Terms and Conditions</h3> 

<p> In using this website you are deemed to have read and agreed to the 
following terms and conditions:</p> 

<p> The following terminology applies to these Terms and Conditions, Privacy 
Statement and Disclaimer Notice and any or all Agreements: 
&quot;Client&quot;, &ldquo;You&rdquo; and &ldquo;Your&rdquo; refers to you, 
the person accessing this website and accepting the Company&rsquo;s terms and 
conditions. &quot;The Company&quot;, &ldquo;Ourselves&rdquo;, 
&ldquo;We&rdquo; and &quot;Us&quot;, refers to our Company. 
&ldquo;Party&rdquo;, &ldquo;Parties&rdquo;, or &ldquo;Us&rdquo;, refers to 
both the Client and ourselves, or either the Client or ourselves. All terms 
refer to the offer, acceptance and consideration of payment necessary to 
undertake the process of our assistance to the Client in the most appropriate 
manner, whether by formal meetings of a fixed duration, or any other means, 
for the express purpose of meeting the Client&rsquo;s needs in respect of 
provision of the Company&rsquo;s stated services/products, in accordance with 
and subject to, prevailing English Law. Any use of the above terminology or 
other words in the singular, plural, capitalization and/or he/she or they, 
are taken as interchangeable and therefore as referring to same.</p> 

<h4> Privacy Statement</h4> 

If you are not familiar with HTML code, Globalscape's Professional Services team offers a range of professional 
services to complement your product solution. 

http://www.globalscape.com/services/pro-services.aspx
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Rebranding (Customizing) the Web Transfer Client 
Before you make any changes to the Web Transfer Client (WTC) files, make a backup copy of any files and 
images that you plan to edit. Deleting or incorrectly editing the WTC files can render the client unusable. When 
you upgrade to a new version of EFT, copy the *changes* to the new files; do not overwrite the new files with 
your custom files as numerous updates will have been made. Copy and then edit the files only in the /custom 
folder as described in the procedure below. 

 

When upgrading EFT, the \web\custom\ and \web\public\ folders are backed up and renamed with the date and time 
(e.g., \customBackup_9-28-2010_16-18\ and \publicBackup_9-28-2010_16-18\). The new versions of the files may have 
some updated content, so rather than overwriting the new files with your old files, you should manually copy your 
customizations to the new files after upgrading. 

EFT provides for custom branding of the per-Site and per-Server login page, WTC interface, Plain-Text Client (PTC), 
Account Management interface, and AS2 Management interface. Save the edited files in the \custom\ directory 
for the Site and\or Server. Each file is searched for independently, so you could have some files branded on the 
Server (under \custom\EFTClient\), others branded on the Site (under \custom\MySite\EFTClient\), and the rest 
left as they were originally installed (under \public\EFTClient\). 

EFT first looks in the Site's custom (branded) directory \web\custom\MySite\EFTClient and loads any branded 
files. For files that are not present in the Site's \custom\ directory, EFT checks the Server's \custom\ directory, 
\web\custom\EFTClient\, and then loads the files that it finds there. Finally, for any other files, it will load the 
default files from \web\public\EFTClient\. Branded files that are Site-specific override any Server-wide branded 
and default files, while branded files that are Server-wide override the default (Globalscape-branded) files 
provided by the installer. 

Upon initial installation, this \custom\ directory is empty. You must create the directory structure for any Server 
(\custom\EFTClient\) or Site (\custom\MySite\EFTClient\) branded files. If you have multiple Sites, each Site can 
have different branding (e.g., one can be in English and one in French). 

• The best practice is to have only customized files in the \custom\ folder and to leave the default files 
unmodified in the \web\public\EFTClient folder. 

• The Site folder \web\custom\[SiteName]\EFTClient\ should hold just those files that contain 
customizations for that Site. 

• The Server folder \web\custom\EFTClient\ should hold just those files that contain customizations for 
the Server. 

• The Server-branded files will apply to all Sites defined on the Server, but any Site-branded files will 
override the Server-branded files. 

• It is not necessary to restart the Site or Server to see your changes, but you will have to refresh or close 
and reopen your browser. 
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Below is an illustration of the folder hierarchy: 

 
To customize the themes style sheet 

The theme_override.css file in C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise\web\public\EFTClient\jument\styles\defaults\styles is an older, minified version of the themes style 
sheet and contains no line breaks, which causes a challenge for editing. A non-minified version of this file is saved 
in C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\styles\, which you 
can edit and then copy over the other one. 

1. In C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\styles\, 
right-click theme_override.css, and save it as a copy. 

2. Open the file in a text editor that can recognize LF line endings, such as Notepad++ or Wordpad. (A basic 
text-editing program like Notepad will not show the line feeds.) 

3. Make your edits, then save the file with the original file name. 

4. Copy and save the file in C:\Program Files (x86)\Globalscape\EFT Server 
Enterprise\web\public\EFTClient\jument\styles\defaults\styles, overwriting the existing file. 

To customize files at the Site level 

1. Create a directory structure in the form [SiteName]\EFTClient\ in the \custom\ folder. 

2. It is not necessary to copy all of the default files from public to custom. Copy the default files that you 
want to edit (rebrand) into the \custom\SiteName\EFTClient folder that you created. 
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3. Edit the copy of the file and save it in the \custom\SiteName\EFTClient\ folder. 

When upgrading, the \custom\ and \public\ folders are backed up and renamed with the date and time (e.g., 
\customBackup_9-28-2010_16-18\ and \publicBackup_9-28-2010_16-18\). 

• If you lack the resources to edit CSS and HTML pages yourself, Globalscape's Professional Services group 
can create custom web pages for you. 

• For information about HTML and CSS files, refer to the MSDN reference at http://msdn.microsoft.com/en-
us/library/aa155133.aspx. 

To customize files at the server level 

1. In the \web\custom\ folder, create a folder named EFTClient. 

2. Copy only the default files that you want to edit (rebrand) for the server into the 
\web\custom\EFTClient\ folder that you created. (It is not necessary to copy all of the default files.) 

3. Make all customizations in the \custom\EFTClient\ folder following the instructions below or contact 
Globalscape Professional Services to request detailed customization services. 

Customizing the WTC 
You can customize the look and feel of the Web Transfer Client (HTML5 version) to suit your organization. The style 
sheets (CSS files) and index.html file are available in the installation folder (e.g., C:\Program Files 
(x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\). The index.html file contains the links 
to the CSS files. 

To alter CSS files (styles) 

1. Navigate to \web\custom\EFTClient\jument\styles\defaults\styles. The CSS files are located in 
\styles\defaults\styles\. 

o vendor.css – the default css from bootstrap and fancytree libraries (You should never have to 
remove the vendor.css reference from index.html) 

o themes.css – the "override" files of these vendor defaults 

o main.css – most of the CSS 

2. Modify styling. 

3. Copy all contents of the defaults folder from \web\custom\EFTClient\jument\styles\ to 
\web\custom\EFTClient\jument\ 

4. If dialogs appear asking if you want to merge folders or replace existing files click Replace or Yes. 

To replace the Globalscape logo with your logo 

1. Copy the *.GSB-Logo.png (there are numbers in place of the asterisk) from the public directory to the 
corresponding custom directory. 

2. Create your logo, sized 150 px by 30 px, and save it with the same name as the default logo. 

3. Replace \web\custom\EFTClient\jument\images\*.GSB-logo.png with your logo. 

4. Close and then reopen the browser to load the changes. 

To replace the Web Transfer Client logo with your logo 

1. Copy the *-App-Logo.png (there are numbers in place of the asterisk) from the public directory to the 
corresponding custom directory. 

2. Create your logo, sized 245 px by 32 px, and save it with the same name as the default logo. 

http://www.globalscape.com/support/professional_services.aspx
http://msdn.microsoft.com/en-us/library/aa155133.aspx
http://msdn.microsoft.com/en-us/library/aa155133.aspx
http://www.globalscape.com/services/pro-services.aspx
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3. Replace \web\custom\EFTClient\jument\images\*-App-Logo.png with your logo. 

4. Close and then reopen the browser to load the changes. 

 
To replace the logo on the login page 

1. Create your logo, sized 400 px by 120 px, and save it with the same name as the default logo. 

2. Replace \web\public\EFTClient\Shared\images\gs-logo-lg.png with your logo. Maintain the same file 
name. 

3. Close and then reopen the browser to load the changes. 

To replace the English text with another language 

NOTE: Subsequent versions are expected to allow for multiple languages. Meanwhile, in the Google Chrome 
browser, if your browser is set for a language other than English, Chrome will ask if you want to translate the page 
into your default language. 

1. In ..\web\custom\EFTClient\jument\il8n\, open main_en.json in a text editor to change the English text 
in the interface to the language that you want displayed. Save a copy of the file before making any 
changes. 

2. In ..\web\custom\EFTClient\Account\, open the HTML files in a text editor to change the English text in 
messages to the language that you want displayed. Be careful to not change any tags in the file. Save a 
copy of the file before making any changes. 

3. Close and then reopen the browser to load the changes. 
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Upgrading the Web Transfer Client 
The HTML 5 version of the Web Transfer Client (WTC) has a separate upgrade wizard from EFT, so that you can 
upgrade the Web Transfer Client as changes are made available without reinstalling all of EFT. You can verify the 
current version by logging in to the WTC and clicking About. 

To upgrade the WTC 

1. Copy the installer (eft-wtc-installer.exe) to the EFT computer and double-click it. The WTC upgrader 
installer opens. 

 
2. Click Next. The license agreement appears. 

 
3. Scroll to read the agreement, then click I Agree. The WTC is upgraded. 
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4. Click Show details to view the process of updating. 

5. After the upgrade is complete, click Close. 

Web Transfer Client Licensing 
With the Web Transfer Client (WTC), users can transfer folders, files, and groups of folders and files to and from 
their local filesystem to a remote filesystem. 

Use of the WTC requires the purchase of a license. Licenses for the WTC are for concurrent users; any number can 
have access, but only the number specified by the license can use the WTC concurrently. 

Use of the WTC requires the purchase of a license for each user. 

The WTC is available for use during 30-day trials of EFT. The trial allows up to 5 licenses. After the trial has expired, 
a license must be purchased for each user who needs to access the WTC. 

You can view the number of licenses purchased in the EFT administration interface (on the main menu, click Help > 
About) and on the Status tab. 

To activate the Web Transfer Client 

1. In the administration interface, click Help > Activate Web Transfer Client. The Registration wizard 
appears. 

2. Follow the instructions in the wizard or refer to Activating the Software, if necessary. 

License Status 

EFT's administration interface displays the number of licenses in use and how many licenses were purchased. In 
version 7.3.2 and later, use of the WTC requires the purchase of a Client Access License (CAL) for each user. WTC 
licenses are defined across all Sites on EFT. The license count applies to all Sites, Settings Templates, and user 
accounts defined on EFT for whom the WTC is enabled. That total number has to be less than the WTC CAL 
purchased. That is, if 30 user accounts have WTC enabled, you must have purchased and activated at least 30 WTC 
licenses. If you have more users than licenses, all users will see s warning message when logging in. A best practice 
recommendation is to move users who don't need to use the WTC to a separate Settings Template and disable the 
use of the WTC on that Settings Template.  

When upgrading, your concurrent WTC licenses will automatically convert to CAL as follows: 

• 5 concurrent = 100 CAL 

• 10 concurrent = 500 CAL 

• 20 concurrent = 5,000 CAL 
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• 50 concurrent = 25,000 CAL 

• 100 concurrent = 100,000 CAL 

If needed, you can purchase unlimited CAL for a Site. 

A WTC session disconnects after 5 minutes of inactivity. User actions such as transfers, browsing the remote 
server, creation, deletion, or the renaming of remote files are seen as activity by the server for keeping the session 
alive. 

When the Site is stopped and restarted, the license count is not reset. If the warning banner appears, you need to: 

• Purchase more licenses 

• Move users to a Settings Template that has WTC disabled. 

• Disable WTC for specific user accounts. 

• Remove or disable user accounts that no longer need access. 

An email is sent to the email address defined on the Server > Logs tab, in the Email Notification area, or the first 
email address defined on the Server > SMTP tab in the Address Book. 

To check Web Transfer Client status 

1. In the EFT administration interface, connect to EFT and click the Server tab. 

2. Click the Server that you want to monitor, and then click the Status tab. 

3. The number of Web Transfer Client (and Workspaces) licenses assigned and remaining are displayed in 
the right pane. 

 
(The "Users Connected" field indicates users connected via FTP. Refer to Status Tab in the EFT help for 
more information.) 

 

In Internet Explorer, a message appears when the user has been disconnected from EFT. 

Web Transfer Client User Guide 
The procedures for configuring and using the Web Transfer Client are described in the topics below. Refer to Web 
Transfer Client Administration for information about configuring the Web Transfer Client on EFT. 

• Notifications 
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Overview of the Web Transfer Client 
The Web Transfer Client (WTC) is a browser-based file transfer client that allows you to transfer files over HTTPS to 
and from a server. Using the WTC, you can upload and download files to the server, pause and resume a transfer, 
cancel a transfer, move files between folders, create, rename, and delete folders and files, and share folders with 
other users. 

 

For details, refer to the following topics: 
• Logging In to the WTC 

• Logging Out of the WTC 

• Uploading Files and Folders 

• Downloading Files 

• Canceling a Transfer 

• Clearing the Upload Manager  

• Resuming Transfers 

• Filtering and Sorting the File List 

• Searching for Files 

• Error Messages and File Names 

• Creating Folders 

• Moving Files Between Folders 

• Sharing Folders 

• File Comments 

• Renaming a File or a Folder 

• Deleting a Folder or File 

• Changing Your Password 
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File-Naming Conventions 
EFT follows the standard Windows naming conventions, with a few exceptions. (Please refer to Unicode File 
Transfers and Unicode Exceptions for details of using Unicode characters.) 

For example: 

• You can name files using almost any character for a name, except for the following reserved characters:  
< > : " / \ | ? * % 

• The maximum length for a path is 255 characters. This limitation includes the drive letter, colon, 
backslash, directories, subdirectories, filename, and extension. If the relative path is too long, a warning 
message appears. 

• Characters that are valid for naming files, folders, or shortcuts include any combination of letters (A-Z) 
and numbers (0-9), plus the following special characters. 

^ 

& 

' 

@ 

{ 

} 

[ 

] 

Accent circumflex (caret) 

Ampersand 

Apostrophe (single quotation mark) 

At symbol 

Brace left 

Brace right 

Bracket opening 

Bracket closing 

$ 

€ 

= 

, 

! 

- 

# 

% 

Dollar symbol 

Euro symbol 

Equal sign 

Comma 

Exclamation point 

Hyphen 

Number sign 

Percent 

( 

) 

. 

+ 

~ 

_ 

Parenthesis opening 

Parenthesis closing 

Period 

Plus 

Tilde 

Underscore 

For more information regarding file-naming conventions, refer to the Microsoft Windows Developer Network 
article Naming a File and the Microsoft TechNet article How NTFS Works. 

Unicode File Transfers 
EFT’s support for UTF-8 encoded Unicode characters extends to: 

Inbound protocols: 

• HTTP/S 

• SFTP 

Event Rules: 

• Copy/Move and Download action wizards (all protocols) when specifying "UTF-8" as the filename 
encoding, and when using wildcards for the source filename, e.g. (*.dat, or *.*) 

• Advanced Workflow Engine when passed filename-related context variables (e.g., %FS.PATH%, 
%FS.FILE_NAME%, etc.) 

Auditing: 

• EFT’s summary Client Log (CL) 

• EFT’s extended client logs (e.g. LAN copy, FTP extended, and SFTP debug logs) 

• EFT’s debug log (Log4Cplus) 

http://msdn.microsoft.com/en-us/library/aa365247.aspx
https://technet.microsoft.com/en-us/library/cc781134%28v=ws.10%29.aspx
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Exclusions*: 

• FTP protocol (inbound) 

• All Event Rule actions that process a filename related context variables (e.g. %FS.PATH%, 
%FS.FILE_NAME%, etc.); the only exception is Advanced Workflow Engine actions 

• Folder Monitor events. Windows will notify EFT when a Unicode file is dropped into a monitored folder, 
but EFT cannot (at present) pass the UTF-8 encoded filename context variable off to Event Rule actions for 
processing. The only exception being when the action is an AWE action, in which case UTF-8 encoding is 
preserved. Do not be tempted to use wildcards as the source filename for Folder Monitor rules (even if 
polling only is used), as this will lead to race conditions and other problems. Wildcards should only be 
used in rules that don’t use filename context variables, such as Timer, user, or system related events. 

• ARM database and all logs not explicitly mentioned above 

• No User Interface (UI) components. This means you cannot specify Unicode characters in Event Rules or 
anywhere else in the administration interface 

• No COM API support for Unicode 

• EFT does not support UTF-8 filenames over AS2 

*UTF-8 will be more comprehensive in a future version. Refer to Unicode Exceptions for more information. 

Unicode FAQs 

The FAQs below are provided to answer questions you may have regarding EFT's Unicode support. 

Q. What is Unicode? 

A. Unicode is a standard that provides a unique number for every character, regardless of platform, program, or 
language. Systems that don’t support Unicode and without the proper ANSI code page will render characters 
such as 大きい魚  ???????.  or  �����. 

Q. Does EFT support Unicode? 

A. EFT partially supports Unicode and is moving towards full support. 

Q. What about UTF-8? 

A. UTF-8 is simply a popular mechanism for encoding Unicode characters using one or more bytes. Prior to 
supporting UTF-8, EFT used ANSI code pages to view filenames in the intended format (on the target system 
when browsing with the WTC or PTC). 

Q. What other mechanisms for encoding Unicode characters does EFT support? 

A. EFT uses full double byte UCS-2 encoding at the file system (I/O) level, UTF-8 encoding within EFT, and ASCII 
everywhere Unicode is not yet supported. 

Q. Does EFT support UTF-8 for file transfers? 

A. EFT preserves UTF-8 encoded filenames when transferring files over HTTP and SFTP when acting as a server, and 
over all supported protocols when acting as a client, when certain conditions are met (see next question). 

Q. What about EFT’s Event Rules? 

A. EFT’s Copy/Move and Download Action wizards (across all protocols) support Unicode when you specify “UTF-8” 
as the filename encoding method (radio button in the wizard), and when using wildcards for the source 
filename, e.g. (*.dat, or *.*). However, UTF-8 is not supported for these Actions if you use %FS.PATH% or any 
other variable for the source filename, which means the Folder Monitor Event cannot be used to offload files 
and conserve their Unicode format. In fact, the only Action that supports UTF-8-encoded filenames through 
context variables is an AWE workflow task. 
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Q. Which client applications can I use to see Unicode filenames when I transfer files to EFT? 

A. EFT's Web Transfer Client (WTC) supports UTF-8. For file transfer applications that do NOT support UTF-8, 
Unicode filenames will appear as "???????.exe" when using them to transfer files to/from EFT. CuteFTP v9 
supports UTF-8. 

Q. Can EFT audit or log filenames or other data with Unicode characters? 

A. EFT’s summary Client Log (CL), extended client logs (LAN transfer logs, FTP logs, SFTP debug logs), and debug log 
(eft.log), and AWE’s logs all support Unicode characters. EFT’s EX logs, cmd out logs, and ARM (both auditing 
and reporting) do NOT support Unicode characters. 

Q. If this filename: 梅雨右折車線_XYZ.ISO is transferred to EFT, how will it appear on disk? In reports? In EFT’s 
Event Rules? 

A. EFT will store the file to disk and conserve the original Unicode filename. The filename will be audited properly 
to EFT’s eft.log, but will be down converted to ASCII when audited to the EX log and to the ARM database, 
resulting in a filename that may look like this: ??????_XYZ.iso, which is also how it appears in EFT’s reports. The 
reason the last three characters and file extension are conserved is that UTF-8 and ASCII characters are 
identical for English characters (A-Z). So there is no loss of meaning (fidelity) after performing a UTF-8-to-ASCII 
conversion. This same UTF-8-to-ASCII conversion applies when EFT hands off the filename to the Event Rule 
dispatcher, except where an AWE action exists, in which case the filename context variable will retain the 
original UTF-8 encoded filename. Thus if data integration of UTF-8 encoded filenames is needed, you should 
consider deploying AWE tasks alongside EFT’s Event Rules. 

Q How do Unicode filenames appear in EFT’s administration interface? 

A. EFT’s administration interface (AI) does not support Unicode characters. UTF-8 is always down converted to 
ASCII in the AI. This means you can’t specify a unique UTF-8 encoded filename in EFT’s offload wizard, a UTF-8 
encoded username, path, or anything else for that matter. The ONLY way to process Unicode filenames in the 
Copy/Move and Download Actions is to use wildcards (*.*, *.dat, etc.) as the source filename, instead of using a 
specific filename such as梅雨右折車線.ISO. 

Q. Will Unicode encoded filenames be preserved in EFT Server’s context variables, such as FS.FILENAME or 
FS.PATH? 

A. Yes and no. For all Event Rule Events, Conditions, and Actions EFT will down convert the UTF-8 characters into 
ASCII. The only exception is when those variables are passed to AWE. In that case alone, EFT conserves the UTF-
8 encoded filename, so that AWE can consume the original UTF-8 encoded filename, as AWE is fully UTF-8 
compliant. 

Q. Does EFT’s internal handling of the file differ depending on whether the file was received in ASCII or Unicode? 

A. In the guts of EFT it handles everything in Unicode. Conversion back to ASCII occurs only when working with a 
system or capability that doesn’t support Unicode. 

Enabling JavaScript in the Browser 
Many web pages use JavaScript (an entirely different language than Java) to make the user experience more 
dynamic. The Web Transfer Client uses JavaScript for this very reason. For the Web Transfer Client to work, 
JavaScript must be enabled in the browser. 

Refer to the procedure below to edit the browser’s security settings to allow you to use JavaScript. See also 
Checking Java Runtime Versions. 

 

You might not have the appropriate permissions to access these settings. If necessary, contact your system administrator 
for assistance. 
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To edit the browser settings 

In Internet Explorer: 

1. Click Tools > Internet Options. The Internet Options dialog box appears. 

2. Click the Security tab, and then click Custom Level. 

3. In the Security Settings dialog box, scroll down to the Scripting area, then under Active scripting, click 
Enable. 

4. Click OK to close the Security Settings dialog box, and then click OK to close the Internet Options dialog 
box. 

In Firefox: 

1. In the address bar, type about:config. 

2. Scroll down to or search for javascript.enabled. 

3. Ensure that the Value column says "true." If it says, "false," double-click the line to change it to "true." 

In Chrome: 

1. In the upper-right corner, click Customize and Control Google Chrome (the icon with 3 horizontal lines), 
then click Settings. 

2. In the Settings page, scroll to the bottom and click Show advanced settings. 

3. Under Privacy, click Content settings. The Content settings dialog box appears. 

4. Under JavaScript, click Allow all sites to run JavaScript, then click Done. 

End-User (Client) Login to EFT 
The EFT administrator should inform end users which IP address, port, username, and password should be used to 
log in to a Site. Because many users are unfamiliar with <IP address:Port> formatting, be sure to provide users with 
the exact URL that they should access to log in, whether they are accessing a Site from the Web Transfer Client, 
"plain-text" client, a command line, CuteFTP, or any other FTP client. For example, you could provide a link in an e-
mail or tell your users: 

In the address box of Internet Explorer, type https://wtc.mycompany.com:4434 

(Refer to Integrated Windows Authentication for Single Sign On (SSO) for details of using IWA for SSO.) 

To log in to EFT to transfer files 

1. Open a web browser to the address provided by the EFT administrator. For example, 
https://mycompany.com/EFTClient/Account/Login.htm. The login page appears.  

• If you do not want to use the Java-enabled version, clear the Java® enabled version check box. 

2. Provide your EFT Username and Password, and then click Log In. 

• If you have forgotten your username or password, click the applicable link. You will be asked for 
your email address to which the reset information will be sent. 

• If the Java® enabled version check box is selected and the proper version of the Java Runtime is 
not installed, a prompt appears asking you if you want to install it. Click Install and follow the 
Java installation wizard. 

• If the Web Transfer Client is not enabled, a less-featured version of the WTC appears. 

• If it is configured in the EFT administration interface, users are prompted to change their 
password the first time they log in. 

https://kb.globalscape.com/KnowledgebaseArticle11035.aspx
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• If a security prompt appears asking you to accept the website's certificate, select the Always 
trust check box, and then click Yes. 

• If the browser is not supported or if the Java applet-enabled version was selected, but Java is not 
enabled, then the "plain-text" client is displayed. 

3. Refer to Web Transfer Client (WTC) for details of transferring files. 

Form-Based Authentication versus Basic Authentication 
EFT uses form-based authentication for users that connect over a browser. It is important to note that a browser is 
defined merely by what is contained in the "user-agent" attribute provided in the HTTP headers. If EFT doesn’t 
recognize the user-agent (such as when connecting with a client application CuteFTP), then EFT will fall back to 
"basic authentication." There is nothing inherently wrong with basic authentication, especially if it is SSL 
encrypted, but form-based is considered superior because it facilitates true session management. However, there 
is another option, which is NTLM authentication, in which EFT attempts to reuse the user’s AD credentials as 
supplied by the browser (assuming the browser supports NTLM), resulting in a single-sign-on (SSO) experience. For 
example, the user authenticates on the company portal, and those credentials are reused by EFT without having to 
ask the user to re-enter them. The downside to NTLM-based authentication is that, like basic authentication, it 
does not support true sessions, so it is up to the users to close their browsers at the end of their sessions to truly 
log out. Another drawback is that when using NTLM, the end user won’t be able to choose between loading the 
Web Transfer Client or the Plain Text Client, won’t be able to access the lost username/password forms, and won’t 
see any of the custom branding. Each of these would be available to the user if they had used the default form-
based authentication. Even in the case where NTLM is enabled, SSO will only apply for Active Directory-based sites 
(because we are talking about AD credentials), and the browser has to be a recognizable user-agent; otherwise, it 
will default to basic authentication (for non-browser) or form-based authentication (for non-AD sites), even if 
NTLM is turned on in the registry.   

• If NTLM is off (by default), then EFT will use form-based authentication for recognized user-agents and 
basic-authentication for all others 

• If NTLM is on (registry enabled), then EFT will use NTLM authentication for AD sites + recognized user-
agent, form based authentication for non-AD sites + recognized user agent, and basic authentication for 
all others (non-recognized user agents). 

Logging In to the WTC 
You can log in to the WTC with any supported browser. The server administrator will provide you with the URL 
(web address) and your login information. 

To log in to the server 

1. Open the web browser. 

2. Type or click the web address provided to you by your system administrator. For example, type 
https://www.ourfileserver.com. The login page appears. 

 

https://kb.globalscape.com/KnowledgebaseArticle11035.aspx
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o If you don't know your username, click Forgot Username. In the Lost Username dialog box, 

provide your email address and then click Submit. 

 
o If you don't know your password, click Forgot Password. In the Lost Password dialog box, 

provide your Username and Email address, then click Submit. 

 
Your request is sent to the server and an automated response will email you your username. 

3. If you have been instructed to use Secure Sign On, click SSO Login. 

4. Provide your Username and Password, then click Log In. When the credentials are accepted by the server, 
the Web Transfer Client (WTC) appears. 

Related topic 

Logging Out of the WTC 
The server ends the session immediately when the browser is closed or after a period of inactivity. When the 
session is ended, the directory listing and any other personal information is cleared, and the login page is 
displayed. 

To log out of the WTC 

• Click Account > Logout. The WTC closes and the Log In page appears. 
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Automatic Log Out 
After a period of inactivity (approximately 10 minutes), a message appears warning that you are about to be 
logged out. You can click Continue to stay connected. 

 

Uploading Files and Folders 
You can upload files and folders from your local computer to a remote server on which you have upload 
permission. 

To upload files between your local system and the server 

• Do one of the following: 

•  

o To transfer files to the server, click File > File Upload. 

o To transfer folders to the server, click File > Folder Upload. 

 Folder uploads are available in Chrome or Opera browser only. If you want to upload 
folders in other browsers, you must compress them (make a ZIP file) and upload the ZIP 
file. 

o Click and drag one or more files or folders from your local file system to the file list. (Empty 
folders will be ignored and not transferred.) 

o In the Upload Manager, click the UPLOAD icon, then select the files and folders that you want to 
upload. 

The File Name pane will refresh automatically after the upload is complete. 

The Upload Manager displays the completed transfers, in-progress transfers (up to 5 at once), and 
pending transfers. The Upload Manager is cleared when the session ends or you log out. 

 

• The PAUSE icon allows you to pause an in-progress transfer. If you want to clear the Transfer queue, you 
can click the CANCEL icon for each transfer or click the CANCEL icon at the top to clear all of the transfers. 
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Notes: 

• When the file is transferred, if there is a file with a duplicate name already in your folder on the server, 
the server will run a comparison on the contents. If the file contents are the same, the file is not 
uploaded. 

• You can upload multiple selected files at once by dragging and dropping from your local system to the 
WTC Upload Manager, or by clicking File > Upload and then selecting multiple files. 

• If you have exceeded your allowed disk quota on the server, a message appears when you attempt to 
upload more files. To continue to upload files, you must delete some of your old files from the server or 
ask your administrator to increase your allowed disk quota. 

• Before you can access the server using the WTC, the administrator must configure the server to allow 
WTC connections with your account. 

• If network connectivity is lost while the WTC is transferring files, you can retry transfers that previously 
failed or were incomplete. If a file partially transferred before the connection went down, the transfer will 
be resumed from the point that it left off. 

Downloading Files 
You can download files from the server to your local computer on which you have download permission. The 
mechanism for downloading files is browser dependent. 

 

The HTML5 version of the Web Transfer Client does not support a CRC-check for downloaded files because of the limited 
access of html/js to the client file system. The process of initiating a download is human driven and can NOT be 
intercepted by a JavaScript API; it is wholly managed by the browser itself, for security reasons. Further, the browser 
cannot arbitrarily read files on the local file system (for obvious security reasons), so EFT cannot read contents of 
downloaded files to do CRC32, and thus cannot issue a follow-up HEAD request to verify the integrity of the download. 

To download files 

• Select the check box of one or more files that you want to download, then click the download icon  on 
the toolbar. 

• The file will download to the folder defined in your browser's configuration (e.g., 
C:\Users\myname\Downloads). 

To open your browser's Downloads folder: 

• In Chrome, click the Settings icon, then click Downloads (or press CTRL+J). 

 

• In Internet Explorer, click the Settings icon, then click View Downloads (or press CTRL+J). 



Web Transfer Client User Guide 

32 

• In Firefox, click green down-facing arrow to view most recent downloads, or type about:downloads in 
the address bar to view all downloads. 

Canceling a Transfer 
Most files that you transfer will transfer so quickly, you won't even notice. Larger files, however, will show 
progress in the In Progress area of the Upload Manager. You can cancel an in-progress transfer. 

To cancel a transfer 

1. In the Upload Manager, while the transfer is in progress, click the PAUSE icon. 

 
2. After the transfer is paused, a Play and a Cancel icon appear. 

 
3. Click the Cancel icon to stop the transfer. 

Clearing the Upload Manager 
The Upload Manager displays the uploads that are completed, in progress, and pending. The pane will clear 
automatically when you log out of the Web Transfer Client. (Removing the list of files from the pane only removes 
it from the display; the file is still saved in the folder into which you transferred it.) 

To clear the Upload Manager 
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After a transfer is completed, the file moves from the In Progress queue to Completed. Click the DELETE icon to 
remove all completed transfers from the queue. 

Resuming Transfers 
A file transfer can be interrupted for various reasons, such as a network glitch, or you might pause the transfer 
yourself. When a transfer is interrupted because of errors, it will resume automatically after network connection is 
reestablished (up to 10 retry attempts over a 5-minute period). 

To resume a paused transfer 

1. Transfers that have been interrupted appear in the In Progress queue. 

 
2. Next to the paused file, click the PLAY icon. The transfer will resume where it left off. 

Filtering and Sorting the File Name Pane 
You can filter the display of the files to display only the files that you want, by name, file type, size, and/or date 
modified to limit the display to specific files and folders. Additionally, you can sort the File Name, Size, and Date 
panes by clicking the arrows in the pane header. 

To filter the File Name pane 

1. Click the funnel icon  in the header of the File Name, Size, or Date pane or next to the Search box. The 
Filter dialog box appears. 
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2. Provide filter criteria such as name, size, or date, then click Apply Filter. 

• To search for a specific size, click Greater than or Less than and provide a size to search for. 

3. To clear your filter and show all files, in the Filter dialog box, click Remove Filter. 

Searching for Files 
If you have a large number of files and subfolders, you can find file more quickly by using filters to search by name, 
size, or date, or typing text in the Search box to find the file. 

The Search box merely matches the text string that you type. For example, it doesn't know the difference between 
a PDF file and a PNG file (however, if you type png, the search results will show all files with png in the file name, 
including the extension). It is not case sensitive. Certain wildcards will return matching results. For example, w*n 
displays results that have a w, one or more other characters, and then an n, such as WEB_VPN_Instructions.docx 
and WindowsClustering.pdf. Wildcards are useful, for example, for finding files when you aren't sure how they 
were named. 

To search for files using a filter 

1. In the search box, type your search term in the box, and then press ENTER, or click the down arrow to do 
a global search. 

2. As you type, the WTC will find matches for what you have typed. 

 
3. Click the found item to navigate to it. 

4. Click the icon on the toolbar for what you want to do with the file (download, rename, delete, move, etc.). 

https://support.office.com/en-US/Article/Examples-of-wildcard-characters-939e153f-bd30-47e4-a763-61897c87b3f4?ui=en-US&rs=en-US&ad=US
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In version 1.1: 

When you first log in to the WTC, the globe icon is light gray. 

 

• Click the globe icon to load the file list from the server. The globe icon will turn white. 

 

• Then, as you start to type in the Search box, the WTC will find matches to what you type. 

 

• Click a file in the search results to select it. The check box next to the file will be selected and the Options 
menu will appear. 

 

• Click the icons in the Options menu to rename, move, or delete the file. 

• Clear the check box to unselect it. 

• Double click the file to save it to your computer. 

Creating Folders 
When you first log in to the Web Transfer Client (WTC), you are in the top folder that you are allowed to view, 
called your home folder. You can create sub folders within this folder, and those folders can have subfolders. 

To create sub folders 

1. In the Folders pane, click to select the folder under which you want to create a subfolder. 

2. On the toolbar, click the NEW FOLDER icon . 

3. Provide a name for the folder, then click OK. (Folder names follow standard Windows file naming 
conventions.) 

4. The new folder appears in the Folders pane. You can now move files between folders and upload files to 
the new folder. 
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Moving Files between Folders 
After you have created subfolders in your home folder, you can move files between the folders. 

To move one or more files to another folder 

1. Select the check boxes of one or more files that you want to move, then click the MOVE icon . 
2. In the dialog box that appears, select the folder to which you want to move the file(s), then click OK. 

File Comments 
You can add and view comments on files in a shared Workspace. 

To view or add comments to a shared Workspace 

1. In a shared folder, select the check box next to a file. (NOTE: Clicking the file will attempt to open it.) The 
toolbar updates to show more options. 

2. With the file selected, click the Comments icon . The Comments dialog box appears. 

 
3. If no comments have been added, the Comments dialog box is blank. 
4. To add comments, type in the text box, then click Save. 

 
5. The dialog box updates to display the comment, the username of the user who entered the comments, 

and the date and time the comments was added. 
6. Click the X in the top right corner to close the dialog box. (Cancel is used to clear a comment before you 

click Save. Once you click Save, the comment is added.) 
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Renaming a File or a Folder 
You can rename folders and files in your home folder and in subfolders. The WTC follows Windows file-naming 
conventions. That is, the following characters are invalid for file naming: 

< > : " / \ | ? * % 

To rename a file or folder 

1. Select the check box for the file or folder that you want to rename. 

2. On the toolbar, click the RENAME icon . 

3. The Rename dialog box appears. Provide a new name, then click OK. 

Deleting a Folder or File 
You can delete folders and files in your home folder and in subfolders. 

To delete a file or folder 

1. Select the check box for the file or folder that you want to delete. 

2. On the toolbar, click the DELETE icon . 

3. The Delete confirmation message appears. Click OK. 

Changing Your Password 
The administrator may have set your password to expire periodically. You can change your password within the 
Web Transfer Client. 

To change your password 

1. In the upper-right corner, click Account, then click Password. The Change Password dialog box appears. 

2. Provide your Current Password and New Password, and then Confirm Password. If the administrator 
requires complex passwords, a message will appear if your password does not meet the complex 
password or reuse password requirements. 

3. Click OK. 

Web Transfer Client Limitations 
The Web Transfer Client (WTC) for EFT v7 has the following limitations: 

• Folder uploads are only available in Chrome or Opera. In EFT v7.1.1.11 and later, you can enable a 
message to appear that will inform the end user, if applicable, that their browser does not support folder 
uploads and will suggest zipping the folder prior to uploading. (See details below.) 

To enable the message 

1. Open the configuration file in a text editor. By default, the file is at: 

C:\Program Files (x86)\GlobalSCAPE\EFT Server 
Enterprise\web\public\EFTClient\jument\scripts\39ba4de0.adminConfig.js 

2. Change 

gsb.config.showSiteInitPopups = false; 

to 

gsb.config.showSiteInitPopups = true; 

http://msdn.microsoft.com/en-us/library/aa365247.aspx
http://msdn.microsoft.com/en-us/library/aa365247.aspx
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Example: 

\Globalscape\EFT Server 
Enterprise\web\public\EFTClient\Jument\scripts\39ba4de0.adminConfig.js 
  
'use strict'; 
/* global gsb */ 
on initialization (e.g., browser incompatibility for feature). */ 
gsb.config.showSiteInitPopups = true; 

3. Save the file. 

A message similar to the following should appear when using Firefox and Internet Explorer: 

 
4. To upload folders, either compress the entire folder and upload the ZIP file, or switch to the Chrome 

browser. 

Error Messages  
Error messages and prompts appear for a variety of scenarios (e.g., if you attempt to upload a file whose path 
exceeds the Windows limit; attempt to create a folder when you do not have permission; the path exceeds the 
Windows limit; a folder with the same name exists; your disk quota is exceeded; and so on). If you have read the 
error message/prompt and are unable to resolve the error yourself, provide the text of the message to your 
system administrator. 

The WTC licensing model uses client-access licenses (CAL). The error below appears when you have more users 
attempting to log in than you have licenses for. The banner will stay displayed until you increase the number of 
licenses available. 

(Administrators, refer to the "WTC Error Messages in EFT" topic in "Web Transfer Client Administration" for other 
error and warning messages.) 
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WTC Logging 
All activity in the WTC is logged in the server. You can view the log of events in the WTC and export the log to send 
to the administrator for troubleshooting. 

To view the log 

1. Click Tools > Log. 

The log appears: 
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To export the log 

1. Click the Export icon in the title of the log window. The log is exported to an HTML file in your browser. 

2. Click anywhere in the HTML page of the log, and then: 

o In a Windows operating system: Press CTRL+A to select all, then CTRL+C to copy the contents 
that are selected. Then, click in an email or text file and press CTRL+V to paste it into the email or 
text file. 

o In a Mac operating system: Press Command+A to select all, then Command+C to copy the 
contents that are selected. Then, click in the email or text file and press Command+V to paste it 
into the email or text file. 
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To change logging settings 

1. Click Tools > Log Options. 

The Log Options dialog box appears. 

 
2. The default logging level is INFO. to increase or decrease the level of logging, click the desired level. Not 

that each logging level will include the logging levels below it. For example, INFO includes all WARN, 
ERROR, and FATAL messages. 

o Click OFF if you want to turn logging off. It is a good idea to leave logging on at the default level 
in case of errors for which the administrator needs to review the logs. 

3. Click OK to accept your changes and close the dialog box. 
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Notifications 
Each Workspace participant can configure notifications to let them know when actions are performed on the 
Workspace, such as uploading or downloading. 

 
To enable notifications 

1. Select the check box for the folder for which you want notifications. 

2. Click the notification icon (bell). The Edit Notification Options dialog box appears. 

3. Specify the notification frequency (the default is daily) and which actions to be notified about (all are 
selected by default). 

4. Click OK to save your changes. 

Workspaces Administration 
The topics in this section explain how to enable, disable, and administer Workspaces. 

 Enabling Workspaces for Outlook 

 Mail Profiles with Multiple Accounts 

 Transactional Workspaces 

 Customizing the Email Interface 

 Enabling Outlook's Language Detection 
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Workspaces Overview 
Workspaces extends the secure and robust EFT file transfer platform with features that allow end users to easily 
share folders with existing and new user accounts, without burdening the IT administrator. Workspaces empowers 
end users to share folders quickly and easily, while IT administrators retain full control and visibility of the file 
transfer infrastructure, leveraging the highest levels of security, regulatory compliance, flexible authentication, and 
data encryption aspects of the EFT platform. No file sync and share vendors have the underlying security features 
empowered by EFT for Workspaces as a sharing solution (DMZ Gateway, multiple secure protocols, workflow 
automation, flexible authentication, etc.). 

 
Administrators Retain Control 

IT Administrators are able to delegate to end users the power of managing shared folders with existing and new 
users without losing governance, visibility, and control. End users are given a tool that fulfills the workflows they 
have become used to (online file sharing) in a way that conforms to corporate policy. Workspaces gives IT 
administrators the freedom to deny access to cloud-based file sharing services within their organization, because 
they have provided a safe alternative to their internal customers. 

When a user's folders are shared, via the Web Transfer Client, the shared folder appears in the EFT administration 
interface on the VFS tab under the Workspace node. 

Here, the administrator can see: 

• With whom the folder is shared 

• What the permissions are on each user account 

• When the Workspace was created 

• The physical path to the folder 

• Who owns the folder 

The administrator can also add or remove specific permissions on the folder for each participant. 
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Licensing Workspaces 
Licenses are purchased per number of Workspaces owners, not the number of Workspaces created. For example, 
if you purchase a 25-seat license, 25 users can create Workspaces; there is no limit to the number of Workspaces 
each owner may possess. (In v7.3.3 and later, you can allow or deny Workspaces creation to specific users.)   

 

Workspaces Licensing versus Web Transfer Client Licensing 
Workspaces are viewed and created in the Web Transfer Client (WTC); therefore, if a user does not have access to 
the Web Transfer Client, the user cannot create or access a shared Workspace. If the user cannot access the WTC, 
the "plain text client" (PTC) appears when the user logs in. 

The flowchart below describes what occurs when a user logs in to EFT in a browser. 

 

Enable and Configure EFT Workspaces 
The Workspaces feature of EFT allows end users to share their folders with other users. The user account that is 
sharing the folder maintains control of permissions to the shared folder, and can revoke sharing privileges at any 
time. 

Workspaces provides the ability to easily share and collaborate on information that is securely managed by EFT, 
including existing authentication, access control, auditing, governance, and Event Rule workflow capabilities 
available in EFT. 
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To enable Workspaces 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 

3. In the right pane, click the Workspaces tab. 

 
4. Select the Enable Workspaces check box. 

5. Under Workspaces Configuration, specify whether to allow EFT users to send invitations to users not in 
the EFT user authentication database. 

o Allow invitations to new EFT users for Workspaces 

o Allow Workspaces shared with existing EFT users only 

6. Specify the maximum expiration period for a Workspace. Senders can set the expiration to happen sooner 
than what is defined on the server, but you cannot specify a longer period. 

7. Click Apply to save the settings. 

A dialog appears asking in which you must specify which Settings Template EFT should place newly invited 
guest users. 

 
8. Specify New, preconfigured Setting Template or Place in existing template.  

9. Click OK. The Guest Accounts Settings Template appears in the Server tree. 
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To enable Workspaces for specific users 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Settings Template or user account. 

3. In the right pane, click the Connections tab. 

 
4. In the Protocols area, select the Allow Creation of Workspaces check box. If this check box is not 

available, you have not activated the Workspaces licenses or the trial has expired; or you have not 
enabled Workspaces for the Site. 

 

HTTPS must also be enabled. 

5. To also allow the use of the Outlook add-in, ensure that the Allow secure file sending check box is 
selected.  

6. Click Apply. 
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Enabling Workspaces to Send Files 
Workspaces for Outlook is an enterprise ad hoc file transfer solution that allows employees to quickly and securely 
send large files right from within Microsoft Outlook. Workspaces for Outlook allows organizations to address broad 
scale, risky file sharing practices while providing an easy-to-use interface for end users that requires little to no 
training from IT staff. Users can quickly and easily send large files via email from within Microsoft Outlook via the 
dedicated add-in, and benefit from an enhanced email experience with advance sending features, such as the 
ability to receive file pick up receipts. Recipients pickup their files in their web browser via a secure link. 
Administrators have the ability to manage user transactions behind the scenes, including the ability to set secure 
link expiration overrides and set policies for the automatic handling of exceedingly large file attachments.   

Before using this feature, the EFT administrator must enable Workspaces and install and enable the EFT Outlook 
Add-In, as shown below. 

To enable Workspaces for Outlook 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Site you want to configure. 

3. In the right pane, click the Workspaces tab. 

4. Select the Enable Workspaces check box, then click Apply. 

5. To configure Workspaces, do one of the following: 

•  Click the Workspaces - Send tab. 

 

• Select the Enable secure file sending check box. 

6. Under Authorized users can send files to, select one of the following options: 

• Existing EFT users only (most restrictive) - Allows EFT users to send files via Workspaces for 
Outlook only to other users with an EFT account 

• Existing EFT user and registered guest accounts - Allows EFT users to send files via Workspaces 
for Outlook to other EFT user accounts and registered guest accounts 
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• Existing EFT users, registered guest accounts, and anonymous users - Allows EFT users to send 
files via Workspaces for Outlook to other EFT user accounts, registered guest accounts, and non-
EFT user accounts. Non-EFT user accounts do not require credentials, making it easy for the 
recipient to pick up files, but makes the system less secure. To reduce this risk, the sender can 
make the pickup link "single use." 

 Transactional Workspaces folders in the VFS that are shared with unregistered users will 
have an exclamation point on the anonymous-access folder 

7. In the Send portal reserved path box, specify the path for the Send portal. The default is /send. 

8. In the Hostname:port box, specify the URL for file pick up. 

9. To require the use of Outlook for large files, do one of the following: 

• (In EFT v7.3.6 and later) If you want to require the use of Outlook for large files, select the Auto-
attach files in Outlook when they exceed check box, and then specify a size. 

• (In EFT v7.3.3-7.3.5) To require the use of Workspaces OAI based on message size, select the 
Enforce use of Workspaces when sending messages from Outlook that exceed <n> MB, then 
specify a size. The default is 10MB. Your limit will depend on your mail server setting. 

10. Specify the maximum expiration period for pickup links. The default is 1 month. 

11. Do one of the following to deploy the EFT Outlook add-in on end-users' computers: 

• Use the EFT Outlook add-in installer: 

 Click Browse to open the EFT installation folder, get the EFT Outlook add-in installer, 
and install the EFT Outlook Add-In as described in Installing the EFT Outlook Add-In. 

-OR- 

• Use the Outlook add-in deployment script: 

a. Click View to open the Outlook Add-in Deployment Script box. 

b. Copy and paste the script into the tool you are using to deploy the Outlook Add-In 
across your organization. 

c. Click OK or press ENTER to close the Outlook Add-in Deployment Script box. 

d. Edit the script to match your environment (i.e., the EFTHOST IP address and port, 
username, password). 

EFT supports Manual authentication, which is really Basic authentication, so you have to 
explicitly provide the user's EFT username and password (that is, the username and 
password that this Add-In user uses to log in to EFT--not the admin credentials). EFT also 
supports Integrated Windows Authentication (IWA) where you don’t have to explicitly 
provide a username and password if you are logged into Windows with your domain 
account. 

Edit the Add-In installer command-line arguments depending on the authentication type you 
want: 

• For manual authentication, do the following (EFTUSERNAME and 
EFTPASSWORD values have to be substituted with the actual Add-in user’s EFT 
username and password): 
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msiexec /lv installation.log /qn /i 
EFTOutlookAddinInstaller.msi EFTHOST=https://WIN-
KST875BEBNP EFTPORT=443 EFTAUTHTYPE=MANUAL EFTUSERNAME=us
ername 
EFTPASSWORD=test123! INSTALLLOCATION="%userprofile%\AppDa
ta\Roaming\GlobalSCAPE\EFT Outlook Add-in" 
FILESTORELOCATION="%userprofile%\AppData\Local\GlobalSCAP
E\EFT Outlook Add-in" 

• For Integrated Windows authentication, do the following (EFTUSERNAME and 
EFTPASSWORD don’t need to be supplied): 

msiexec /lv installation.log /qn /i 
EFTOutlookAddinInstaller.msi EFTHOST=https://WIN-
KST875BEBNP EFTPORT=443 EFTAUTHTYPE=IWA INSTALLLOCATION="
%userprofile%\AppData\Roaming\GlobalSCAPE\EFT Outlook 
Add-in" 
FILESTORELOCATION="%userprofile%\AppData\Local\GlobalSCAP
E\EFT Outlook Add-in" 

Mail Profiles with Multiple Accounts 
Outlook 2007 supports a maximum of one mail account per mail profile. As such, the Outlook Add-In for this 
version of Outlook supports a mail profile with a single mail account. 

Outlook 2010 and later supports mail profiles with multiple mail accounts. The Outlook Add-In seamlessly works 
with this new feature and (from a user standpoint) there is no real difference in how the Add-In is used. Emails 
with attachments can be sent from any of the mail accounts in the profile and the Add-In will manage the emails 
that meet the policy criteria, as usual. If an email is sent with the download notification feature turned on, the 
notifications will be sent to the account from which the email was sent. The Status pane will show an aggregated 
view of all packages that are being managed by the Add-In for all accounts. If an account is disconnected from its 
mail server, the Add-In will wait until connectivity is re-established for that account before uploading commences. 

The Outlook Add-In is supported with the following mailbox types: 

• Outlook 2007 supports a single MAPI or POP (not both at the same time) 

• Outlook 2010 and later support MAPI and POP 

Workspaces Invitations 
An EFT administrator can invite internal users to join existing Workspaces in the VFS tab. External users cannot be 
invited via the VFS tab; they can only be invited by email address in the Web Transfer Client (WTC). 

When a user is invited via the WTC, EFT follows the following logic flow: 

1. EFT will first look for a matching email address in the existing Site user profiles and usernames. For 
example, let's say a Workspaces folder owner invites a user to share a folder with the email address 
test@gs.com. EFT will search for a user in the existing Site for either a username of "test@gs.com" or a 
username with an associated email of test@gs.com. If a match is found, then EFT sends an email to the 
invited user to let them know that they have been invited to share a Workspaces folder. Internal users are 
not invited, they are automatically joined. 

2. If more than one internal user is associated with the invited email address, either by username or profile 
e-mail address, EFT will decline to add the user. 

3. If the email address is not associated with any internal username or email profile and the Site-level 
Workspaces tab has the Allow invitation to new EFT users for Workspaces option enabled, then EFT will 
add the user to the Workspaces folder as a "pending" user, and the user will be invited to create an EFT 
account to gain access to the shared folder. However, if the option is not enabled, then the invitation 
request will be denied. 
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Internal Users 

When adding participants to Workspaces folders, the email address is the unique participant identifier. Existing 
users will be added to a Workspaces folder only if there is one and only one match for the e-mail address being 
invited. Before completing an invitation, EFT will check both the username and email address fields for all users on 
the Site for matching addresses. 

• If two internal EFT users on the same Site have the same email address, they cannot both be joined to 
the same Workspaces folder. For example, if user accounts test2 and test3 each  have the email address 
user@gs.com, and the administrator attempts to add users test2 and test3 to a Workspaces folder, EFT 
will not permit test3 to join, and will state that it's due to duplicate users. In the WTC, the "Unspecified 
error has occurred" message will appear. If Workspaces trace level logging is enabled, then the log will 
report the offending email address. 

• If one user’s username is the same as another user account's e-mail address and a Workspace owner 
attempts to invite that address, an error will occur and the user will not be invited. 

External (non-EFT) Users 

When external users are invited to join a Workspaces folder, they must individually accept and activate each and 
every Workspaces invitation. The recipient must accept each invitation and fill out the "Already Have an Account" 
form to gain access to the Workspaces folder. 

• EFT doesn't provide any sort of visual indicator to distinguish between internal users vs. external users. 
When external users join a Workspaces folder, their user accounts are created under EFT's Default User 
Settings Template. External users are permitted to create Workspaces, but cannot invite new external 
users to share the folder. External users can only invite users who already have an EFT account. 

• The EFT VFS tab indicates which users are in the "pending" state, meaning they have not yet accepted 
their invitations. Once a user accepts an invitation, the "Pending" status is removed. Externally invited 
users have 5 days to accept and activate a pending invitation, after which the invitation will expire. This is 
a hard-coded value and cannot be modified. 

• Workspace owners and EFT administrators are not notified when an external user's invitation expires. 
When an invitation expires, the user is automatically removed from the Workspaces folder and no longer 
will appear as a pending user. There is no resend-invitation option. In order to re-invite an external user 
whose invitation has expired, the Workspaces owner, via the WTC, has to re-invite the user, at which 
point the invited user will go back into a pending status and will again have 5 days to activate the account. 
Pending user status can only be viewed via the VFS Tab. 

 

Workspaces Notifications 
When a Web Transfer Client user shares a folder, an invitation is sent to the user with whom the folder is shared. If 
the recipient does not have an account on EFT, the user can register the account. (On AD/LDAP Sites, you can only 
invite users in the Active Directory domain.) For invitations sent to non-EFT users, an email is sent to verify the 
account when the user registers the account. 

The text for the invitation and verification emails is contained in an HTML file that can be customized for 
localization or to provide company-specific information. 
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Workspaces invitations expire after 5 days. 

The files are stored in the ProgramData directory (by default, C:\ProgramData\Globalscape\EFT Server Enterprise) 
and apply to all Sites on the Server. (The path is shown on the Server's General tab, under General Settings > 
Server configuration settings.) 

 
You can edit the files in any text editor. Note that the "WS" variables used in these notification templates are used 
only in these templates. They are not Event Rules variables. 

The files are named per their function: 

• WorkspaceNotification.txt - Used to notify the Workspace owner that a recipient took an action on a file. 

• WorkspacesAdminAddedParticipantMsg.html - Used to notify recipients that a Workspace was shared 
with them. 

• WorkspacesInviteRegisterMsg.html - Used to notify recipients that a Workspace was shared with them 
and they are invited to register an account on EFT. 

• WorkspacesInviteVerifyMsg.html - Sent after recipient has registered for an EFT account and needs to 
verify the account. 

• WorkspacesOAIEmail.html - Notification to recipients that a file has been sent (from Outlook). 

• WorkspacesOAIEmail.txt - Text version of the notification to recipients that a file has been sent (from 
Outlook). 

To edit the Workspaces invite and verify messages 

1. In the administration interface, connect to EFT and click the Server tab. 

2. On the Server tab, click the Server node. 

3. In the right pane, click the General tab. 
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In the General Settings area, next to Workspaces invite message, click the browse icon. Your default text 
editor (e.g., Notepad) opens with the invitation text. 

 
Edit the text as needed, being careful not to delete the variables (%USER.EMAIL_ADDRESS%, 
%WS_OWNER_NAME%, %FOLDER_NAME%, %LINK%), then save the file and close the text editor. 

 

The WS_ variables are not Event Rule variables. To use Workspaces variables in Event Rules, refer to the Variables list. 

4. Next to Workspaces verify message, click the browse icon. Your default text editor (e.g., Notepad) opens 
with the verify text. 
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5. Edit the text as needed, being careful not to delete the variables (%USER.EMAIL_ADDRESS%, %LINK%). 

6. Save the file and close the text editor. 

Workspaces Permissions 
Workspaces permissions are separate from the VFS permissions, such as those permissions for the Usr folders. 
Users who have Workspaces permissions on a folder will not appear in the VFS permissions for that folder. For 
example (as shown below): 

1. "imauser2" has full permissions on the \Usr\imauser2\ folder in VFS. 

2. In Workspaces, "imauser2" has shared a folder called "folder 2" with "imauser1." 

3. When the administrator clicks "folder 2" in the Workspace Folder tree, you can see that "imauser1" has 
Workspaces permissions on that folder. 

4. However, only "imauser2" has VFS permissions on that folder. 
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Specify Custom Default Workspaces Sharing Permissions 

By default, all Workspaces permissions are selected, and the user is expected to clear any permissions that you do 
want to give the invitee when a folder is shared. Alternatively, the EFT administrator can change the default 
permissions so that one or more permissions are NOT selected by default, and then the user sharing the folder has 
to explicitly enable the permission. Changing the defaults does NOT disable the permission; it simply is not 
selected by default. The sharing user can still enable it when inviting users to share a Workspace. 

To specify default sharing permissions 

1. In C:\Program Files (x86)\Globalscape\EFT Server Enterprise\web\public\EFTClient\jument\scripts, find 
the adminConfig.js file. (There is a number in front of the name.) 

2. Open the configuration file in a text editor, such as Notepad++. (It may be necessary to change the 
extension from JS to TXT to view it properly.) 

3. Look for the Default permissions section and the following text: 

gsb.config.defaultWSPermissions = { 
    canUploadFile: true, 
    canDownloadFile: true, 
    canDeleteFile: true, 
    canRenameFileFolder: true, 
    canCreateFolder: true, 
    canDeleteFolder: true 
}; 

4. For the permission that you do NOT want selected by default, change true to false, then save the file. For 
example, if you do not want the Delete File permission selected by default, change canDeleteFile: true to 
false. 

5. If you changed the name of the file to edit it, be sure to change it back. 

https://notepad-plus-plus.org/download/v6.8.3.html
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Workspaces Permissions on an Active Directory Site 

Workspaces has the ability to invite external users on an Active Directory Site. Described below is what occurs 
when a non-AD account has been invited to a Workspace, what permissions the EFT Server enforces for file 
activity, and how that applies to the "Comments" feature of Workspaces. This is important because the basic 
behavior of an AD Site, independent of Workspaces, is that any client that logs in as an AD account will 
subsequently access all files exposed by EFT's protocol engines using that very same AD account used to log in 
(known as "impersonation"). Thus, it is not EFT that enforces file system permissions to local and UNC paths; it is 
the Windows operating system. 

When EFT allows non-AD users to gain access to this Site (when we allow invitations to external parties) then we 
no longer impersonate an AD user and, therefore, our EFT application is limited in access by the service account 
under which it runs; however, this might be more permissive than the permissions for any individual user in the AD 
server. 

For example, suppose your organization's AD users have READ/WRITE access to everything on a shared drive, and 
have explicit DELETE permission to our own folder but no one else's folder. Suppose the IT administrator set up a 
Folder Monitor rule against the shared drive. The IT administrator would have to run the EFT service as an AD 
account that had READ/WRITE/DELETE permissions across the whole shared drive so that the Folder Monitor 
workflows can move or delete files, or so that the EFTArchive operation worked, and so on. 

Suddenly, there is a security concern: Any externally invited Workspace user will act against the shared drive the 
same as the EFT service account, not an individual AD account. 

THEREFORE¸ our application itself must impose permissions checks on all file access for such accounts (which, by 
the way, is exactly how LDAP, Local, and ODBC authentication work). 

EFT server will perform a permissions check on any assignment of Workspaces permissions to a participant 
(creation or modification time). EFT compares the OWNER permissions to the requested Workspaces permissions 
for a participant, and ensures at that moment that the OWNER does not grant MORE permission to a given folder 
than that which the owner of the folder holds. 

All file activity within a Workspace is managed by EFT to conform to ONLY those permissions allowed by the 
Workspace configuration. Therefore, EFT enforces that Workspace permissions are equal to or less privileged than 
the owner's permissions, regardless of the service account under which EFT operates. 

Below is a summary table that describes the permissions checks EFT applies to Workspace file and Comments 
activity for both OWNERS and for PARTICIPANTS upon adding or modifying participants in a Workspace: 

Operation on file or 
comments Required Owner EFT VFS permissions Required Participant Workspace permissions 
ADD PERMISSION_FILE_APPEND or 

PERMISSION_FILE_UPLOAD 
canUploadFile 

UPDATE PERMISSION_FILE_APPEND or 
PERMISSION_FILE_UPLOAD 

canUploadFile 

DELETE PERMISSION_FILE_APPEND or 
PERMISSION_FILE_UPLOAD 

canUploadFile 

GET PERMISSION_DIR_LIST N/A – Means that Participant can read comment 
because Owner invited them to Workspace. 

For example, for the invited user to be able to comments to files, *both* of the following conditions must be met: 

• Owner must have Append or Upload EFT VFS permission for that file. 

• Participant (invitee) must be granted the Upload Workspace permission by the inviter. 
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Managing Workspaces in the VFS 
The VFS tab has a Workspaces view in which EFT Server- and Site-level administrators can: 

• Delete shared Workspaces 

• Add existing users to existing Workspaces 

• Modify participant permissions of shared Workspaces 

Sharing folders via the VFS tab 

• Workspaces cannot be created via the VFS tab. 

• External users cannot be invited via the VFS tab. External users can only be invited via the WTC. 

• Users joined to Workspaces via the VFS tab, unlike users joined via WTC, are not sent invitation 
notification emails. 

• Workspaces permissions may be granted via the VFS Workspaces view, however, the permissions may not 
be permitted. The VFS tab will appear to permit all user permissions to be granted to a Workspaces 
participant, however, the available permissions extend from the Workspaces owner's folder permissions. 
Suppose an EFT user creates a shared folder with only Upload permissions; an EFT administrator may 
invite participant1 to join the Workspaces folder, granting participant1 full administrative privileges to the 
folder. However, participant1 will receive an "access denied" response if they attempt to perform any 
actions within the folder other than upload, because the Workspaces folder respects the Workspaces 
owner's folder permissions. 

 

Managing Workspaces in the VFS 
The VFS tab has a Workspaces view in which EFT Server- and Site-level administrators can: 

• Delete shared Workspaces 

• Add existing users to existing Workspaces 

• Modify participant permissions of shared Workspaces 
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Sharing folders via the VFS tab 

• Workspaces cannot be created via the VFS tab. 

• External users cannot be invited via the VFS tab. External users can only be invited via the WTC. 

• Users joined to Workspaces via the VFS tab, unlike users joined via WTC, are not sent invitation 
notification emails. 

• Workspaces permissions may be granted via the VFS Workspaces view, however, the permissions may not 
be permitted. The VFS tab will appear to permit all user permissions to be granted to a Workspaces 
participant, however, the available permissions extend from the Workspaces owner's folder permissions. 
Suppose an EFT user creates a shared folder with only Upload permissions; an EFT administrator may 
invite participant1 to join the Workspaces folder, granting participant1 full administrative privileges to the 
folder. However, participant1 will receive an "access denied" response if they attempt to perform any 
actions within the folder other than upload, because the Workspaces folder respects the Workspaces 
owner's folder permissions. 

 

Transactional Workspaces 
A Transactional Workspaces is a special kind of Workspace that results from sending a file for pick up from the EFT 
Outlook Add-In. The recipient only has download permission on the file(s) received. Transaction Workspace 
participants cannot see each other and cannot subscribe to notifications. 

 
This Workspace is different from normal Workspaces in that a Transactional Workspace: 

• Accepts anonymous access, if the administrator allows it and the owner/sender chooses 

o Transactional Workspaces folders in the VFS that are shared via public links (unregistered users) 
will have an exclamation point on the anonymous-access folder 

• Grants permission to download only 
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• Can't have participants added post creation 

• Owner will have little power over it once created 

• Is a private, in that participants can't see each other 

• Is private, in that participants can't subscribe to notifications (although owner/sender can) 

• Is represented in the VFS tab using the Subject line and the sender's username 

• Is represented differently in the WTC 

• Content gets deleted when it expires 

• Is more likely to have a shorter maximum expiration period than regular Workspaces 

• Supports self-expiring, single-use file links, which are not supported in regular Workspaces 

Outlook Activity Reports 
With the Auditing and Reporting module, EFT provides reports of Outlook Send, and Outlook Pickup activities. 

 

 
Refer to Reporting for information about reports. 

Customizing the Email Interface 
The EFT administrator can customize (brand) the email interface with your company logo, color scheme, and so on. 
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Refer to Customizing the WTC for details of changing the logo and style of the page. 

  

Enabling Outlook's Language Detection 
The EFT Outlook Add-In uses Outlook's proofing language detection to determine in which language an email is 
written. If you want to enable the Auto detect email language setting, you must enable Outlook's Detect language 
automatically proofing setting. 

Before Outlook's Detect language automatically option can detect the language that you are typing and enable 
the proofing tools for that language, you must turn on the language-specific options you want to use. 

To turn on language specific options 

• For Microsoft Office 2007, refer to the Microsoft Office article at http://office.microsoft.com/en-
us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010243503.aspx. 

• For Microsoft Office 2010 and later, refer to the Microsoft Office article at http://office.microsoft.com/en-
us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010354783.aspx. 

To enable Outlook's Detect language automatically proofing setting 

• For Outlook 2007, refer to the Microsoft Office article at http://office.microsoft.com/en-us/outlook-
help/turn-on-automatic-language-options-HA010244823.aspx. 

• For Outlook 2010 and later, refer to the Microsoft Office article at http://office.microsoft.com/en-
us/outlook-help/turn-on-automatic-language-options-HA010354274.aspx. 

 

From the Microsoft Office links above: "Automatic language detection does not work on a single-word basis, but on a 
sentence basis. Depending on the length of your sentences, you might need to type several sentences before Outlook 
has enough contextual information to automatically detect the language and apply the correct dictionary." 

http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010243503.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010243503.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010354783.aspx
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-languages-in-your-office-programs-HA010354783.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010244823.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010244823.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010354274.aspx
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-options-HA010354274.aspx
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Outlook must be restarted for the changes to take effect. After you have turned on the language-specific options in 
Microsoft Office and enabled Outlook's Detect language automatically proofing setting, then the Add-In's 
automatic language detection feature will be enabled. 

Workspaces User Guide 
The topics below provide information about Workspaces and procedures for enabling, configuring, and using 
Workspaces. 

• Sending Files with the Outlook Add-In 

• Emailing Files from within the WTC 

• Viewing Add-In Status 

• Connecting to EFT from Outlook 

• Enabling or Disabling the Outlook Add-In in Outlook 

• EFT Outlook Add-In Interface 

• Configuring Message Options 

• Recovering an Email from "Unrecoverable Error" 

• Changing the Message Format in Outlook 

Sharing Folders (Creating a Workspace) 
Users can share an EFT folder with other EFT users through the Web Transfer Client. Additionally, you can, if the 
EFT administrator allows it, invite external users to share your folders. (To share folders, the administrator has to 
have enabled Workspaces in the EFT administration interface on the Workspaces tab of the Site.) Users outside of 
the EFT network who were invited to share a Workspace (externally provisioned users) cannot themselves invite 
new users. 

The invitation recipient clicks the link embedded in the email and then signs in to EFT, if an account has previously 
been created, or creates an account on EFT. 

To share a folder 

1. Log in to the Web Transfer Client. 

2. Select the check box of the folder that you want to share, then click the Share Folder icon , or click File 
> Share Folder. The Create a Workspace dialog box appears. 
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3. Provide up to 10 email addresses of users with whom you want to share the folder. (You can later add 

more participants, 10 at a time. To add more than 10, the EFT administrator can edit the WTC files. Refer 
to the Knowledgebase for details.) 

4. To create a private workspace, select the Make this workspace private check box. When a Workspace is 
private, the Alerts/Notification icon, the Workspace participants icon, and the comments icon are hidden 
from the recipient. 

5. Assign permissions by clearing or selecting the check box next to that permission. By default, all 
permissions are selected (enabled). Clear the check boxes of the permissions that you do not want to 
assign to the users. 

 

The administrator can specify which permissions check boxes are selected by default, if any. The sharing user 
can still select the check box to enable the permission. Refer to Workspaces Permissions for details. Permissions 
that the administrator assigns to folders override any permissions that you assign. That is, if the folder that you 
are sharing does not have rename permission, you cannot assign that permission to the folder. 

6. (Optional) In the Messages box, you can type comments. When you create a Workspace, the comment 
that you type in the Messages box appears in the invitation email.  

• View a history of comments added by clicking the shared folder and then clicking the comment 
icon. 
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7. In the Notifications box, you can specify the type and frequency of email notifications about this 

Workspace. 

8. (Optional) (In EFT v7.2.1 and later) To allow users to expire the Workspace, select the Workspace 
expiration check box, and then specify the expiration. The limit is specified in the administration interface 
on the Workspaces tab of the Site. 

9. Click Share 

10. The folder icon changes to indicate that the folder is shared . 

If you click the folder, a message indicates with whom the folder is shared and allows you to add more 
participants. 

11. To make participant changes for the shared folder, click the link in the message (in this case "4 more"). 

The Edit Workspace Participants dialog box appears. 
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a. To view a participant's permissions, click the gear icon   for that participant. 

 
b. To remove a participant form the list, click the trash can icon   for that participant. 

The deleted user(s) will no longer have access to that folder. This action does not delete the user 
from the system nor prevent the user from accessing other Workspace folders on which they 
have permissions. 

c. To add more users to the shared folder, click add more participants. 



Workspaces v1.3 User Guide 

65 

 
11. The users with whom you have shared the folder will see the shared folder in their Joined Workspaces 

tree. 

12. In the EFT administration interface, on the VFS tab, the shared folder appears in the Workspace Folder 
tree, and the administrator can see who has shared the folder, who has access to the folder, and what 
each participants' permissions are. On the VFS tab, the administrator can add or remove permissions and 
add/remove users from the share. 

 
13. To stop sharing the folder, thereby removing the folder from Joined Workspaces, click the stop sharing 

icon in the banner . The Stop Sharing Workspace message appears. 
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Sending Files with the Outlook Add-In 
If you have ever sent an email with attachments, you already know how to use the Outlook Add-in. Create the 
email, attach one or more files to the email, then click Send. You will continue to send and receive emails as 
always; the only difference is that the Outlook Add-in works transparently in the background to transfer the emails 
that have attachments. 

• The sent email is still saved to your Sent Items folder, but the attachments, if managed by the Outlook 
Add-in, are not saved in the Sent Items folder. Instead, a link to the attachments is added to the body of 
the email. The email saved to your Sent Items folder looks the same as the recipient's received email, 
minus the attachments. 

• The attachment and message, if managed by the Outlook Add-in, is saved on EFT server in the location 
specified during installation, in a unique folder for each email, not on your SMTP server (such as Microsoft 
Exchange). 

• The Outlook Add-in stores information about emails that it is processing in an individual workspace. 

• The administrator configures message-sending options on the EFT server. You can configure more strict 
options in Outlook for all messages or for specific messages. Refer to Configuring Message Options for 
details. 

Sending the email can fail in the following situations: 

• Offline mode—Messages are stored in the outbox until Outlook is online and the Add-In connects to the 
server. 

• Loss of connectivity to the server—Interrupted uploads due to loss of connectivity to the server are 
continued from the point at which they were stopped when connection to the server is re-established. 

• Insufficient disk space—The Add-In will receive a FileSystemError response from the server and the Add-
In will treat this as an unrecoverable error. 

• RTF-formatted emails—RTF-formatted messages are not supported. To change the format for all 
messages sent in Outlook, refer to Changing the Message Format. 

To send a file 

1. Create an email as usual. 

2. Attach the file to the email using the EFT Outlook Add-in Offload Attachments button. 
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3. (Optional) Click one or more of the following options: 

• Expire File Links—When selected, the ability to download the attachments will expire in the time 
that you specify. If the recipient attempts to download a file that is past its expiration date, the 
following message appears: “The file you are attempting to download has expired. Please contact 
the sender if this file needs to be resent.” 

• Authentications—Require the user to log in to download an attachment from the Pick-up portal. 
Selecting this check box helps prevent unwanted downloads from email forwarding and such, 
and also helps guarantee that the person downloading the file is the intended recipient. 

o If the user clicks on an individual file link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, the "open/save" 
dialog appears. 

o If the user clicks on the Pick-up portal link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, they will be taken 
to the Pick-up page for that specific package. 

o When the check box is selected, only the Pick-Up page link is sent. If the check box is not 
selected, individual links for each file are included in the email. 

The authentication will be saved in their session, so clicking multiple individual file links will not 
require multiple log-ins. (The session length is 10 minutes.) 

• Notifications—When selected, download notification is sent to you when the recipient clicks the 
download link in the email or Download Files on the Pick-Up page. 

4. Click Send. The email the recipient will receive will be similar to the example below. 
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5. The recipient can download the attachment "package" from the Web Transfer Client. 

 
6. If the attachment does not appear, the recipient might need to click the refresh icon. Select the check box 

next to the file, then click the Download icon. The file is saved to the recipient's browser downloads 
folder. 

Emailing Files from within the WTC 
EFT users who want to email files from their computer or the WTC can do securely from within the WTC. 
Recipients of those files can pick up the files in their default browser. 
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• The browser will timeout after a period of inactivity. Files that are being uploaded are considered 
"activity." Idle timeout occurs if you leave the browser open and stop composing your message with no 
activity. Upon timeout, the draft is lost. An "about to timeout" warning prompt is displayed when timeout 
is imminent, giving you the opportunity to keep the session alive. 

To send files 

1. Log into the WTC. 

2. Click the Send icon   on the toolbar. The Send files securely form appears. 

 
3. Select the files that you want to send: 

o Files on your computer (in the Select a file dialog box or drag and drop): 
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- or - 

o Files on EFT (displayed in the WTC): 

 
4. Specify message options. Select the Save as defaults check box to use the same settings every time. 
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5. Click Apply, then click Send Message. A message appears indicating whether the message was sent 
successfully or not. When using the send portal, one of the following messages appears: 

  
 

 

The Not Sent message only appears if you have EFT configured to send only to EFT users (most restrictive) and 
you try to send to non-EFT users. If you need to send to user accounts that are not defined in EFT, your EFT 
administrator will need to either change the setting on the Workspaces - Send tab of the EFT Site or add the 
account as an EFT user. 

6. Depending on the success or failure of the message, you can click Send another or Try again to send 
another message. 

If sending the message was successful, the recipient(s) receive an email with a link to pick up the files. 
When they click that link, their default browser opens to the Pickup portal. 

 
  

When picking up files, the recipient(s) can: 

o Read the body of the email. 

o Select the files to download. 
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Viewing Add-In Status 
The EFT Outlook Add-In includes a Status pane through which you can view whether you are connected to EFT and 
the status of email attachments being sent. By default, the Status pane is hidden. The pane appears on the right 
side of the main Outlook window. 

To view EFT Outlook Add-in status 

• On the EFT Outlook Add-In toolbar/ribbon, click Display Status. The EFT Outlook Add-in Status pane 
appears. 

 
o The General Status area displays the status of your server connection. If the Outlook Add-In is 

not connected to the server, it will not try to upload packages. 

o The Transfer Status area displays the status of attachments being sent, including recipient, 
subject line, size of the file, status (Pending, Transferring, Verifying File Digest, etc.), and the 
number of upload attempts. 

o To dock or undock the Status pane 

 Click and hold the title bar of the Status pane until the Move cursor  appears (or click 
the down arrow on the title bar of the pane, then click Move) then drag the pane to 
undock it and move it where you want. 

 To dock the pane, click in the title bar, and drag the pane back to the right or left side of 
the primary Outlook window. 

 To resize the pane (when undocked) click and hold a corner of the pane (or click the 
down arrow on the title bar of the pane, then click Size), then drag the pane to the size 
you want. 

o If the upload failed, the Transfer Status area displays the following information: 

 Text-based description of current status, including information on what prevented 
package from being uploaded in error cases 

 Subject of the package 
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 Recipients of the package 

 Total size of package 

 Number of upload retry attempts for package 

 Recover Email button for failures that were the result of an unrecoverable error. Clicking 
Recover Email moves the email to the Outlook Drafts folder. 

Connecting to EFT from Outlook 
Typically, the EFT Outlook Add-In server connection information is configured by the administrator. You should not 
edit these settings unless directed to do so by your administrator. Reasons why you might want to edit these 
settings are if your username/password has changed, if the server is moved to another host, if your login type was 
changed, or if you need to change the log file location. 

If the EFT Outlook Add-In is not connected to the server, it will not try to upload packages. 

In the General Configuration dialog box, accessed from the EFT Outlook Add-In toolbar/ribbon, you can specify to 
which server you want to connect, how to authenticate your connection, and where to save log files. In most 
cases, your administrator will configure this for you during setup. 

To configure the EFT Outlook Add-In 

1. On the EFT Outlook Add-In toolbar/ribbon, click General Configuration. The General Configuration dialog 
box appears. 

 
2. In the EFT Server Host box, provide the host name of EFT. 

3. In the Port box, provide the port used by EFT for HTTPS connections. 

4. In the Authentication type box, specify either manual or Windows authentication: 

• Manual—You must provide the username and password that you use to connect to EFT or your 
AD credentials. 

a. In the Username box, provide the username that you use to connect to EFT or your AD 
username. 

b. In the Password box, provide the password that you use to connect to EFT or your AD 
password. 

Use the EFT login credentials for the EFT user account, not the administrator. 
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• Integrated Windows Authentication—Used this login type if you connect to EFT via Single Sign 
On (Kerberos). In this case, you do not need to provide a username and password. Your Windows 
credentials are used to connect. 

5. If you want to test your connection, click Test Connection. 

6. (Optional) In the Log file location box, specify the path at which the log file is saved. 

7. Click OK to save your changes, or click Cancel if you do not want to save your changes. 

Enabling or Disabling the Outlook Add-In in Outlook 
If the EFT Outlook Add-In options do not appear in Outlook you need to enable it. Or in the rare instance of an 
error, you may you need to disable the Outlook Add-In or reenable it. 

To enable or disable the Outlook Add-In 

In Outlook 2010 or later: 

1. Click File > Options. 

2. In the left pane, click Add-Ins. 

3. In the Manage box, click COM Add-Ins, then click Go. The COM Add-Ins dialog box appears. 

4. Select (turn on) or clear (turn off) the EFT Outlook Add-In check box, then click OK. 

Take note of the state of the Add-In in the Trust Center (i.e. Active, Inactive, or Disabled). If the Add-In is 
in a disabled state, it cannot be enabled using the steps above initially. Instead, you must perform the 
following steps in the Trust Center: 

a. Next to the Manage box, click Disabled Items, then click Go. 

b. In the Disabled Items dialog box, click EFT Outlook Add-In, then click Enable. 

c. Close the Disabled Items dialog box. 

If the Add-In now appears in the Active list, it is enabled. If the Add-In appears in the Inactive list, follow 
steps 3-4 above. 

In Outlook 2007: 

1. Click Tools > Trust Center. 

2. In the left pane, click Add-Ins. 

3. In the Manage box, click COM Add-Ins, then click Go. The COM Add-Ins dialog box appears. 

4. Select (turn on) or clear (turn off) the EFT Outlook Add-In check box, then click OK. 

Take note of the state of the Add-In in the Trust Center (i.e. Active, Inactive, or Disabled). If the Add-In is 
in a disabled state, it cannot be enabled using the steps above initially. Instead, you must perform the 
following steps in the Trust Center: 

a. Next to the Manage box, click Disabled Items, then click Go. 

b. In the Disabled Items dialog box, click EFT Outlook Add-In, then click Enable. 

c. Close the Disabled Items dialog box. 

If the Add-In now appears in the Active list, it is enabled. If the Add-In appears in the Inactive list, follow 
steps 3-4 above. 



Workspaces v1.3 User Guide 

75 

EFT Outlook Add-In Interface 
The EFT Outlook Add-In allows you to send files from Outlook for pickup via a secure link. 

When the user interface is enabled, the EFT Outlook Add-in options are available in Outlook: 

 
When you create a new email, the EFT Outlook Add-In options appear: 

 

• If the EFT Outlook Add-in does not appear in Outlook, refer to Enabling or Disabling the Outlook Add-In. 

• If the EFT Outlook Add-in options are grayed out, check the following: 

o The account used to connect to EFT is not valid. Be sure that an EFT user account is used to 
connect to EFT. 

o The Add-in is unable to communicate with the EFT server. This could be caused by a number of 
issues, including incorrect connection information, invalid or blocked user account, or blocked IP 
address from multiple invalid connections. 

o Outlook Add-in is disabled in Outlook or in EFT. 
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Configuring Message Options in Outlook 
You can configure message options for all e-mails or for a specific email. In each email that you send, you can 
specify message options that pertain to that email only, overriding the default send options. You can make these 
settings stricter, but not less strict. Each procedure is described below. 

Use the Message Options dialog box to specify whether the EFT Outlook Add-in should: 

• Expire links 

• Use authentication 

• Notify on pickup 

• Manage embedded attachments 

• Queue or send emails when EFT is not available 

To configure message options to apply to ALL e-mails 

1. On the EFT Outlook Add-In toolbar/ribbon, click Message Options. The Message Options dialog box 
appears. 

 
2. On the Default Send Options tab, specify expiration, authentication, and notification options. 

3. If you want EFT to manage embedded attachments, such as a signature logo, select the Manage 
embedded attachments check box. 

4. On the Offline behavior tab, specify the following options: 
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• Queue e-mails until EFT server is available—Emails are sent after EFT server becomes available. 

• Send emails via Outlook without EFT Outlook Add-in—Emails are sent immediately, but not 
managed by EFT. 

• Prompt me for desired behavior—Display a prompt when EFT is not available so you can choose 
whether to send immediately or hold the email until EFT is available. 

5. Click OK to save your changes, or click Cancel if you do not want to save your changes. 

To configure send options for a specific email 

1. Create the email as you normally do. 

2. In the EFT Outlook Add-In area, click the options you want to change just for this email. 

3. In the Send Options dialog box, you can specify the following options: 

• Offload attachments—Embedded attachments are files that are inserted into the body of the 
email rather than attached to the email, such as a company logo in an email signature or a 
picture. If you want to make these embedded attachments into file download links, select the 
check box. (Cleared by default.) 

• Expire File Links—When selected, the ability to download the attachments will expire in the time 
that you specify. If the recipient attempts to download a file that is past its expiration date, the 
following message appears: “The file you are attempting to download has expired. Please contact 
the sender if this file needs to be resent.” (Cleared by default.) 

• Authentications—Require the user to log in to download an attachment from the Pick-up portal. 
Selecting this check box helps prevent unwanted downloads from email forwarding and such, 
and also helps guarantee that the person downloading the file is the intended recipient. 

•  

o If the user clicks on an individual file link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, the "open/save" 
dialog appears. 

o If the user clicks on the Pick-up portal link, the login or account creation page will be 
displayed in their default browser. After authentication is successful, they will be taken 
to the Pick-up page for that specific package. 

o When the check box is selected, only the Pick-Up page link is sent. If the check box is not 
selected, individual links for each file are included in the email. 

The authentication will be saved in their session, so clicking multiple individual file links will not 
require multiple log-ins. (The session length is 10 minutes.) 

• Notifications—When selected, download notification is sent to you when the recipient clicks the 
download link in the email or Download Files on the Pick-Up page. 

4. Click OK to save your changes or Cancel if you do not want to save your changes. 
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Recovering an Email from "Unrecoverable Error" 
The Add-In will try to automatically recover from problems such as loss of connectivity with EFT during a transfer. 
If the Add-In experiences an “Unrecoverable Error” while managing a package, the Recover Email button appears. 
An unrecoverable error is a more serious error that the Add-In cannot resolve on its own, such as a file system 
error caused by EFT running out of disk space. These types of errors will usually require an administrator to 
resolve. 

 
If you click Recover Email, the Add-In will move the email corresponding to the package from Outlook’s Outbox to 
the Drafts folder. You can then try resending the email, perhaps after the administrator has had a chance to 
resolve the issue. If the problem cannot be resolved in a timely fashion, but you need to send the email promptly, 
you can stop the Add-In from managing emails by turning it off via the Outlook Trust Center. 

• To turn off the Outlook Add-In, refer to Enabling or Disabling the Outlook Add-In. 

• To edit message options, refer to Configuring Message Options. 

Changing the Message Format in Outlook 
RTF-formatted messages are not supported. The procedures below describe how to change the message format, 
depending on your version of Outlook. 

Changing the Message Format in Outlook 2010 and later 
To change the message format for all messages 

1. Click the File tab. 

2. Click Options. 

3. Click Mail. 

4. Under Compose messages, in the Compose messages in this format list, click HTML or Plain Text. 

To change the format of an individual message 

1. With the message open, click Format Text. 

2. On the Format tab, click the format you want to use (Plain Text or HTML). 
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Changing the Message Format in Outlook 2007 
To change the default message format for all messages 

1. On the Tools menu, click Options, and then click the Mail Format tab. 

2. In the Compose in this message format list, click HTML or Plain Text. 

To change the format of an individual message 

1. With the message open, click Options. 

2. On the Format tab, click the format you want to use (Plain Text or HTML). 
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